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Introduction

Getting Help

NOSA template

 NOSA template
http://xml.noaa.gov/xml/templates/nosa/nosa_template.kmd#oid1
Initial NOSA template.
Metamodels
The following list of sub topics displays all the metamodels available from the NOSA template template.
 NOSA Version 0.5
NOSA Version 0.5

 NOSA Version 0.5
xe "Metamodel : NOSA Version 0.5"http://xml.noaa.gov/xml/metamodels/nosa_metamodel.kmd#oid1
The NOAA Observing System Architecture metamodel.
Viewstyles
The following list of sub topics displays all the viewstyles available from the NOSA Version 0.5 metamodel.
 NOSA View Style
Object Types
The following list of sub topics displays all the object types available from the NOSA Version 0.5 metamodel.
 Actual Measurement
 Sensor Type
 Sensing Element
 Processing Element
 Platform/Station
 Phenomenon Requirement
 Organization
 Observing System
 Observation Control System
 Mobile Location Data
 Required Measurement
 Location
 Group
 Fixed Location Data
 Environmental Product
 Environmental Phenomenon
 Environmental Parameter
 Data Handling System
 Characterization requirement
 Platform/Station Type
 Message
Relationship Types
The following list of sub topics displays all the relationship types available from the NOSA Version 0.5 metamodel.
 Applies to
 Transmits
 Supplied by
 Use
 Area of Operations
 Has contact person
 Provides info to
 Provides data to
 Funds
 User
 Primary stakeholder
 Owns
 Situated on
 Contains
 Provides data for
 Measures
 Supports
 Operates
 Characterizes
 Drives
 Reported to
 Located at
 Secondary stakeholder
 Downstream user
 Acquires
 Provides data directly to
 Is controlled by
 Part of
 Is type of
 Leads to
 Takes
 Sent to
 Met by
Sub Metamodels
The following list of sub topics displays all the sub metamodels available from the NOSA Version 0.5 metamodel.
 Variable classification
Variable classification

 Variable classification
xe "Metamodel : Variable classification"http://xml.noaa.gov/xml/metamodels/nosa_metamodel.kmd#oid3
Object Types
The following list of sub topics displays all the object types available from the Variable classification metamodel.
 Category
 Term
 Topic
 Variable
 Category
xe "Object Type : Category"http://xml.noaa.gov/xml/object_types/category.kmd#oid1
	


	Default Symbol


Basetype
 Modeling Object with name and description properties
Properties
Inherited properties
 Modeling Object with name and description properties : Name
Property Name: name
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
Note that this property is also the label property. The value for the label property can be displayed on a tooltip (when the preference is set in Metis) and is usually displayed on the symbol. The value of this property is also displayed for the object in the Object and View trees.
 Modeling Object with name and description properties : Description
Property Name: description
Property Type: Description with Rich Text [Standard type: ANSI C++ string (long)]
 Term
xe "Object Type : Term"http://xml.noaa.gov/xml/object_types/term.kmd#oid1
	


	Default Symbol


Basetype
 Modeling Object with name and description properties
Properties
Inherited properties
 Modeling Object with name and description properties : Name
Property Name: name
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
Note that this property is also the label property. The value for the label property can be displayed on a tooltip (when the preference is set in Metis) and is usually displayed on the symbol. The value of this property is also displayed for the object in the Object and View trees.
 Modeling Object with name and description properties : Description
Property Name: description
Property Type: Description with Rich Text [Standard type: ANSI C++ string (long)]
 Topic
xe "Object Type : Topic"http://xml.noaa.gov/xml/object_types/topic.kmd#oid1
	


	Default Symbol


Basetype
 Modeling Object with name and description properties
Properties
Inherited properties
 Modeling Object with name and description properties : Name
Property Name: name
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
Note that this property is also the label property. The value for the label property can be displayed on a tooltip (when the preference is set in Metis) and is usually displayed on the symbol. The value of this property is also displayed for the object in the Object and View trees.
 Modeling Object with name and description properties : Description
Property Name: description
Property Type: Description with Rich Text [Standard type: ANSI C++ string (long)]
 Variable
xe "Object Type : Variable"http://xml.noaa.gov/xml/object_types/variable.kmd#oid1
	


	Default Symbol


Basetype
 Modeling Object with name and description properties
Properties
 Standard
Property Name: standard
Property Type: string [Standard type: ANSI C++ string (short)]
Standard defining this parameter, e.g. GCMD.
Inherited properties
 Modeling Object with name and description properties : Name
Property Name: name
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
Note that this property is also the label property. The value for the label property can be displayed on a tooltip (when the preference is set in Metis) and is usually displayed on the symbol. The value of this property is also displayed for the object in the Object and View trees.
 Modeling Object with name and description properties : Description
Property Name: description
Property Type: Description with Rich Text [Standard type: ANSI C++ string (long)]
 NOSA View Style
xe "Viewstyle : NOSA View Style"http://xml.noaa.gov/xml/viewstyles/nosa_viewstyle.kmd#oid1
Type Views
	Object Type
	Open Symbol
	Closed Symbol

	

Container
	

	



 Actual Measurement
xe "Method : getContactPerson (Actual Measurement)"

xe "Method : getGoal (Actual Measurement)"

xe "Object Type : Actual Measurement"http://xml.noaa.gov/xml/object_types/actual_measurement.kmd#oid1
	


	Default Symbol


Basetype
 NOSA Abstract Basetype
Connections with other Object Types
	Direction
	Relationship Type
	Object Type

	

	Has contact person
	Person

	

	Measures
	Environmental Parameter

	

	Supports
	Goal

	

	Characterizes
	Environmental Phenomenon

	

	Takes
	Sensing Element

	

	Met by
	Required Measurement


Properties
 Actual Measurement Name
Property Name: name
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
Enter the name of this Environmental Parameter.
Note that this property is also the label property. The value for the label property can be displayed on a tooltip (when the preference is set in Metis) and is usually displayed on the symbol. The value of this property is also displayed for the object in the Object and View trees.
 Description
Property Name: description
Property Type: Description with Rich Text [Standard type: ANSI C++ string (long)]
Provide a short description of this measurement.
 Measurement -> Algorithm
Property Name: measurement.algorithm
Property Type: text [Standard type: ANSI C++ string (long)]
Describe at a high level how this environmental parameter is derived. (E.g., Apparent Temperature is calculated using Air Temperature, Humidity, and Wind Speed.)
 Measurement -> Measurement Unit
Property Name: measurement.unit
Property Type: Unit []
Specify the units this parameter is normally expressed in.
 Measurement -> Minimum Measurement Value
Property Name: measurement.min
Property Type: float [Standard type: 64 bit floating point]
Specify the lower measurement bound (minimum) for this parameter expressed in the units selected in the Measurement Unit property.
 Measurement -> Maximum Measurement Value
Property Name: measurement.max
Property Type: float [Standard type: 64 bit floating point]
Specify the upper measurement bound (maximum) for this parameter expressed in the units selected in the Measurement Unit property.
 Measurement -> Representative Measurement Accuracy
Property Name: measurement.accuracy
Property Type: float [Standard type: 64 bit floating point]
For the given sensing element specify representative measurement accuracy. Measurement Accuracy represents the systematic error as specified by the difference between a measured or derived parameter and its true value in the absence of random errors.
 Measurement -> Representative Measurement Precision
Property Name: measurement.precision
Property Type: float [Standard type: 64 bit floating point]
For the given sensing element specify representative measurement precision. Measurement Precision is the uncertainty in a measured or derived parameter due only to random errors, specified as the standard deviation of a parameter. 
 Measurement -> Representative Measurement Uncertainty
Property Name: measurement.uncertainty
Property Type: float [Standard type: 64 bit floating point]
For the given sensing element specify representative measurement uncertainty. Measurement Uncertainty is the root-mean-square of the measurement errors for an estimated parameter. 
 Environmental Parameter Timeline
Property Name: timeline
Property Type: text [Standard type: ANSI C++ string (long)]
Describe the measurement timeline for this Environmental Parameter including sampling, integrating, and reporting process. Address latency and persistence if known.
 Timeline Unit
Property Name: timelineUnit
Property Type: string [Standard type: ANSI C++ string (short)]
Enter the timeline unit (e.g. seconds, minutes)
 Reporting Frequency
Property Name: reportingFrequency
Property Type: float [Standard type: 64 bit floating point]
Provide the shortets Reporting Frequency (e.g. 10 minutes) for this Environmental Parameter.
 Sample Frequency
Property Name: sampleFrequency
Property Type: float [Standard type: 64 bit floating point]
If different from Reporting Frequency, provide the shortest Sample Frequency for this Environmental Parameter. 
 Sampling Duration
Property Name: samplingDuration
Property Type: float [Standard type: 64 bit floating point]
Provide the shortest Sample Duration for this Environmental Parameter.
 Measurement Stability
Property Name: measurementStability
Property Type: text [Standard type: ANSI C++ string (long)]
Describe the Environmental Parameter stability addressing both the time needed to average over to ensure the averaging out of noise, but short enough so that meaningful analysis/trends/results are derived.
 Measurement Extent
Property Name: measurementExtent
Property Type: text [Standard type: ANSI C++ string (long)]
Describe the measurement extent (e.g. temperature at a single point, fish in a given area, soil moisture for a given cylinder with depth, or aerosol extinction as a function of sensing depth).
 Mapping Uncertainty
Property Name: mappingUncertainty
Property Type: text [Standard type: ANSI C++ string (long)]
Specify necessary mapping (location and extent) accuracy for this envrionmental parameter.
 Other Key Parameters
Property Name: otherKeyParameters
Property Type: text [Standard type: ANSI C++ string (long)]
Please define other key parameter properties your program uses that were not requested above that describe the measurement fidelity. Please review the remote sensing section for coverage related properties.
 General Coverage Description
Property Name: coverage
Property Type: text [Standard type: ANSI C++ string (long)]
 Point of Contact
Property Name: pointOfContact
Property Type: string [Standard type: ANSI C++ string (short)]
Use the Contact Person of relationship to establish a link to the contact person.
 GIS Coverage Data
Property Name: gisCoverageData
Property Type: text [Standard type: ANSI C++ string (long)]
 Driving Requirements
Property Name: drivingRequirements
Property Type: text [Standard type: ANSI C++ string (long)]
 Key Questions
Property Name: keyQuestions
Property Type: string [Standard type: ANSI C++ string (short)]
 Interested Community
Property Name: interestedCommunity
Property Type: string [Standard type: ANSI C++ string (short)]
 Strategic Goals
Property Name: strategicGoals
Property Type: string [Standard type: ANSI C++ string (short)]
Use the Supports relationship to establish a link to one of the 7 strategic goals.
 Other Needs
Property Name: otherNeeds
Property Type: text [Standard type: ANSI C++ string (long)]
Inherited properties
 NOSA Abstract Basetype : DBIF Identifier
Property Name: id
Property Type: string [Standard type: ANSI C++ string (short)]
Unique identifier of this object. Used for the Database Interface import.
Methods
 getContactPerson
http://xml.noaa.gov/xml/object_types/actual_measurement.kmd#oid11
 getGoal
http://xml.noaa.gov/xml/object_types/actual_measurement.kmd#oid13
 Sensor Type
xe "Object Type : Sensor Type"http://xml.noaa.gov/xml/object_types/sensor_type.kmd#oid1
	


	Default Symbol


Basetype
 NOSA Abstract Basetype
Connections with other Object Types
	Direction
	Relationship Type
	Object Type

	

	Is type of
	Sensing Element


Properties
 Name
Property Name: name
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
Note that this property is also the label property. The value for the label property can be displayed on a tooltip (when the preference is set in Metis) and is usually displayed on the symbol. The value of this property is also displayed for the object in the Object and View trees.
 Description
Property Name: description
Property Type: Description with Rich Text [Standard type: ANSI C++ string (long)]
Inherited properties
 NOSA Abstract Basetype : DBIF Identifier
Property Name: id
Property Type: string [Standard type: ANSI C++ string (short)]
Unique identifier of this object. Used for the Database Interface import.
 Sensing Element
xe "Method : getEnvironmentalParameter (Sensing Element)"

xe "Method : getSensorType (Sensing Element)"

xe "Method : Open Reference Material 1 (Sensing Element)"

xe "Method : Open Reference Material 2 (Sensing Element)"

xe "Object Type : Sensing Element"http://xml.noaa.gov/xml/object_types/sensing_element.kmd#oid1
	


	Default Symbol


Basetype
 NOSA Abstract Basetype
Connections with other Object Types
	Direction
	Relationship Type
	Object Type

	

	Supplied by
	Organization

	

	Contains
	Observing System

	

	Provides data for
	Processing Element

	

	Is type of
	Sensor Type

	

	Takes
	Actual Measurement


Properties
 Sensing Element Name
Property Name: name
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
Enter the name of the Sensing Element
Note that this property is also the label property. The value for the label property can be displayed on a tooltip (when the preference is set in Metis) and is usually displayed on the symbol. The value of this property is also displayed for the object in the Object and View trees.
 Acronym
Property Name: acronym
Property Type: string [Standard type: ANSI C++ string (short)]
Enter the acronym for this Sensing Element.
 Identifier
Property Name: identifier
Property Type: string [Standard type: ANSI C++ string (short)]
Enter the Sensing Element identifier, if applicable. If not enter NA. An example would be ASOS F420 wind sensor.
 Sensor Type
Property Name: sensorType
Property Type: string [Standard type: ANSI C++ string (short)]
Indicate the type of sensor.
 Measured Environmental Parameters
Property Name: environmentalParameter
Property Type: string [Standard type: ANSI C++ string (short)]
Identify the Environmental Parameters measured by this Sensing Element. This value is transferred from the name property of the associated Environmental Parameter(s)
 Description
Property Name: description
Property Type: Description with Rich Text [Standard type: ANSI C++ string (long)]
Provide a short description of this Sensing Element. Include its key characteristics, major modes of operation, upgrade plans, etc.
 Reference Material 1
Property Name: refMaterial1
Property Type: url [Standard type: URL as xlink]
Enter a URL to a file containing reference material. Check 'Relative' if the URL is relative to the model location.
 Reference Material 2
Property Name: refMaterial2
Property Type: url [Standard type: URL as xlink]
Enter a URL to a file containing reference material. Check 'Relative' if the URL is relative to the model location.
Inherited properties
 NOSA Abstract Basetype : DBIF Identifier
Property Name: id
Property Type: string [Standard type: ANSI C++ string (short)]
Unique identifier of this object. Used for the Database Interface import.
Methods
 getEnvironmentalParameter
http://xml.noaa.gov/xml/object_types/sensing_element.kmd#oid21
 Open Reference Material 1
http://xml.noaa.gov/xml/object_types/sensing_element.kmd#oid10
 Open Reference Material 2
http://xml.noaa.gov/xml/object_types/sensing_element.kmd#oid11
 getSensorType
http://xml.noaa.gov/xml/object_types/sensing_element.kmd#oid23
 Processing Element
xe "Object Type : Processing Element"http://xml.noaa.gov/xml/object_types/processing_element.kmd#oid1
	


	Default Symbol


Basetype
 NOSA Abstract Basetype
Connections with other Object Types
	Direction
	Relationship Type
	Object Type

	

	Transmits
	Message

	

	Provides data to
	Data Handling System

	

	Contains
	Observing System

	

	Provides data for
	Sensing Element

	

	Provides data directly to
	Organization


Properties
 Name
Property Name: name
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
Enter the name of the Processing Element
Note that this property is also the label property. The value for the label property can be displayed on a tooltip (when the preference is set in Metis) and is usually displayed on the symbol. The value of this property is also displayed for the object in the Object and View trees.
 Description
Property Name: description
Property Type: Description with Rich Text [Standard type: ANSI C++ string (long)]
Enter a description for the Processing Element
Inherited properties
 NOSA Abstract Basetype : DBIF Identifier
Property Name: id
Property Type: string [Standard type: ANSI C++ string (short)]
Unique identifier of this object. Used for the Database Interface import.
 Platform/Station
xe "Method : getOrganizationOperator (Platform/Station)"

xe "Method : getOrganizationOwner (Platform/Station)"

xe "Method : getPlatformStationType (Platform/Station)"

xe "Method : Open Webpage (Platform/Station)"

xe "Object Type : Platform/Station"http://xml.noaa.gov/xml/object_types/platform_station.kmd#oid1
	


	Default Symbol


Basetype
 NOSA Abstract Basetype
Connections with other Object Types
	Direction
	Relationship Type
	Object Type

	

	Owns
	Organization

	

	Situated on
	Observing System

	

	Operates
	Organization

	

	Located at
	Mobile Location Data

	

	Located at
	Fixed Location Data

	

	Is type of
	Platform/Station Type

	

	Owner type
	Organization


Properties
 Name
Property Name: name
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
Enter the name of the Platform or Station
Note that this property is also the label property. The value for the label property can be displayed on a tooltip (when the preference is set in Metis) and is usually displayed on the symbol. The value of this property is also displayed for the object in the Object and View trees.
 Acronym
Property Name: acronym
Property Type: string [Standard type: ANSI C++ string (short)]
Enter the acronym that this Platform or Station is known by
 Identifier
Property Name: identifier
Property Type: string [Standard type: ANSI C++ string (short)]
Enter the Platform or Stations identifier, if any. For example, P3 is the identifier for the Orion aircraft.
 Type
Property Name: type
Property Type: string [Standard type: ANSI C++ string (short)]
Identify the type of Platform or Station
 Description
Property Name: description
Property Type: Description with Rich Text [Standard type: ANSI C++ string (long)]
Enter a short description of this Platform or Station. Describe how it is used in relation to the Observing System
 Owner Type -> Commercial
Property Name: ownerType.commercial
Property Type: Boolean [Standard type: Boolean enum type]
 Owner Type -> Foreign
Property Name: ownerType.foreign
Property Type: Boolean [Standard type: Boolean enum type]
 Owner Type -> Military
Property Name: ownerType.military
Property Type: Boolean [Standard type: Boolean enum type]
 Owner Type -> NOAA
Property Name: ownerType.noaa
Property Type: Boolean [Standard type: Boolean enum type]
 Owner Type -> Other USG agency
Property Name: ownerType.usg
Property Type: Boolean [Standard type: Boolean enum type]
 Owner Type -> University
Property Name: ownerType.university
Property Type: Boolean [Standard type: Boolean enum type]
 Owner
Property Name: owner
Property Type: string [Standard type: ANSI C++ string (short)]
This value is transferred from the name property of the associated owner Organizations.
 Operator
Property Name: operator
Property Type: string [Standard type: ANSI C++ string (short)]
This value is transferred from the name property of the associated operator Organizations.
 Webpage
Property Name: webPage
Property Type: url [Standard type: URL as xlink]
Identify the URL for a webpage that describes this Platform or Station
 Operational Regime
Property Name: regime
Property Type: Operational Regime []
Identify where the platform primarily operates
 Spatial Coordinates (Mobile)
Property Name: spatialCoordinates
Property Type: text [Standard type: ANSI C++ string (long)]
Describe the locations where the platform operates in terms of the boundaries of its travel. The transit region can be described in terms of geographic feature (eg, North Atlantic), bounds (eg, between 35 and 45 N Lat), corners (eg, NW corner at 35N/45E, etc), track (eg, starts at point X and ends at point Y), or satellite ephemeris data.
 Temporal Characteristics (Mobile)
Property Name: temporalCharacteristics
Property Type: text [Standard type: ANSI C++ string (long)]
Describe the characteristics of the mobile platform in terms of velocity profiles, transit times, revisit times, and so on.
Inherited properties
 NOSA Abstract Basetype : DBIF Identifier
Property Name: id
Property Type: string [Standard type: ANSI C++ string (short)]
Unique identifier of this object. Used for the Database Interface import.
Methods
 Open Webpage
http://xml.noaa.gov/xml/object_types/platform_station.kmd#oid10
 getOrganizationOperator
http://xml.noaa.gov/xml/object_types/platform_station.kmd#oid25
 getOrganizationOwner
http://xml.noaa.gov/xml/object_types/platform_station.kmd#oid23
 getPlatformStationType
http://xml.noaa.gov/xml/object_types/platform_station.kmd#oid27
 Phenomenon Requirement
xe "Method : Open Source Document (Phenomenon Requirement)"

xe "Object Type : Phenomenon Requirement"http://xml.noaa.gov/xml/object_types/phenomenon_requirement.kmd#oid1
	


	Default Symbol


Basetype
 Requirement
Properties
 Source Document
Property Name: sourceDocument
Property Type: url [Standard type: URL as xlink]
Enter the URL for the source document for this requirement, if one exists. Check 'Relative' if the URL is relative to the model location.
 Identifier
Property Name: id
Property Type: string [Standard type: ANSI C++ string (short)]
Inherited properties
 General Requirement : Name
Property Name: name
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
Enter a short name for the object
Note that this property is also the label property. The value for the label property can be displayed on a tooltip (when the preference is set in Metis) and is usually displayed on the symbol. The value of this property is also displayed for the object in the Object and View trees.
 General Requirement : Description
Property Name: description
Property Type: Description with Rich Text [Standard type: ANSI C++ string (long)]
Enter a description of the object
 General Requirement : No Label
Property Name: priority
Property Type: Priority []
Priority of the requirement.
 General Requirement : No Label
Property Name: Color
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
Methods
 Open Source Document
http://xml.noaa.gov/xml/object_types/phenomenon_requirement.kmd#oid10
 Organization
xe "Criterium : Find Owned Observing Systems (Organization)"

xe "Criterium : Find Primary Stakeholder Of Organization (Organization)"

xe "Object Type : Organization"http://xml.noaa.gov/xml/object_types/organization.kmd#oid1
	


	Default Symbol


Basetype
 Organization
Connections with other Object Types
	Direction
	Relationship Type
	Object Type

	

	Supplied by
	Sensing Element

	

	Has contact person
	Person

	

	User
	Observing System

	

	Primary stakeholder
	Observing System

	

	Drives
	Environmental Phenomenon

	

	Drives
	Environmental Parameter

	

	Secondary stakeholder
	Observing System

	

	Downstream user
	Observing System


Properties
 DBIF Identifier
Property Name: id
Property Type: string [Standard type: ANSI C++ string (short)]
Unique identifier of this object. Used for the Database Interface import.
 Organization Code
Property Name: orgCode
Property Type: string [Standard type: ANSI C++ string (short)]
Enter the Organization Code.
 Mail Code
Property Name: mailCode
Property Type: string [Standard type: ANSI C++ string (short)]
Enter the Mail Code.
Inherited properties
 Organization : Name
Property Name: name
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
Enter a short name for the object
Note that this property is also the label property. The value for the label property can be displayed on a tooltip (when the preference is set in Metis) and is usually displayed on the symbol. The value of this property is also displayed for the object in the Object and View trees.
 Organization : Description
Property Name: description
Property Type: Description with Rich Text [Standard type: ANSI C++ string (long)]
Enter a description of the object
 Organization : Phone no.
Property Name: phoneNr
Property Type: PhoneNr [Phone Nr]
Telephone number used to contact the organization
 Organization : Fax no.
Property Name: faxNr
Property Type: PhoneNr [Phone Nr]
Fax number
 Organization : Country
Property Name: country
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
 Organization : X-400
Property Name: x400
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
 Organization : E-mail
Property Name: email
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
 Organization : City
Property Name: city
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
 Organization : Address 2 (Po. Box)
Property Name: address2
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
 Organization : URL
Property Name: url
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
 Organization : Manager
Property Name: manager
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
The name of the person responsible for the organization. This property will automatically be filled in if you connect a Person object with the Is Manager For relationships.
 Organization : ZIP
Property Name: zip
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
Zip code part of the address
 Organization : Address 1
Property Name: address1
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
 Organization : Homepage
Property Name: homepage
Property Type: string [Standard type: ANSI C++ string (short)]
Homepage URL
 Organization : Int/Ext Classification
Property Name: type
Property Type: Int Ext Classification []
 Organization : Image
Property Name: image
Property Type: string [Standard type: ANSI C++ string (short)]
Criteria
 Find Owned Observing Systems
http://xml.noaa.gov/xml/criteria/criteria.kmd#oid4
 Find Primary Stakeholder Of Organization
http://xml.noaa.gov/xml/criteria/criteria.kmd#oid1
 Observing System
xe "Method : getHigherSystem (Observing System)"

xe "Method : getOrganizationAcquires (Observing System)"

xe "Method : getOrganizationDownstreamUser (Observing System)"

xe "Method : getOrganizationFunds (Observing System)"

xe "Method : getOrganizationPrimaryStakeholder (Observing System)"

xe "Method : getOrganizationSecondaryStakeholder (Observing System)"

xe "Method : getOrganizationUser (Observing System)"

xe "Method : Open Block Diagram (Observing System)"

xe "Method : Open Reference URL (Observing System)"

xe "Method : Open Schedule (Observing System)"

xe "Method : Open System Picture (Observing System)"

xe "Object Type : Observing System"http://xml.noaa.gov/xml/object_types/observing_system.kmd#oid1
	


	Default Symbol


Basetype
 NOSA Abstract Basetype
Connections with other Object Types
	Direction
	Relationship Type
	Object Type

	

	Area of Operations
	Location

	

	Funds
	Organization

	

	Funds
	Observing System

	

	Funds
	Observing System

	

	User
	Organization

	

	User
	Group

	

	Primary stakeholder
	Organization

	

	Primary stakeholder
	Group

	

	Owns
	Organization

	

	Situated on
	Platform/Station

	

	Contains
	Sensing Element

	

	Contains
	Processing Element

	

	Supports
	Goal

	

	Supports
	Organization

	

	Operates
	Organization

	

	Secondary stakeholder
	Organization

	

	Secondary stakeholder
	Group

	

	Downstream user
	Organization

	

	Downstream user
	Group

	

	Acquires
	Organization

	

	Is controlled by
	Observation Control System

	

	Part of
	Observing System

	

	Part of
	Observing System


Properties
 System Name
Property Name: name
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
Enter the name of this observing system.
Note that this property is also the label property. The value for the label property can be displayed on a tooltip (when the preference is set in Metis) and is usually displayed on the symbol. The value of this property is also displayed for the object in the Object and View trees.
 Acronym
Property Name: acronym
Property Type: string [Standard type: ANSI C++ string (short)]
Enter the acronym that this system is known by.
 Identifier
Property Name: identifier
Property Type: string [Standard type: ANSI C++ string (short)]
Enter the systems identifier, if any. For example, WSR-88D is the identifier for NEXRAD.
 Description
Property Name: description
Property Type: Description with Rich Text [Standard type: ANSI C++ string (long)]
Enter a description of the system.
 Primary Mission Need Statement
Property Name: primaryMissionNeed
Property Type: text [Standard type: ANSI C++ string (long)]
Provide a short (5-20 words) description of the mission supported by this system. (This should not be a repeat of the strategic goals).
 Secondary Mission Need Statement
Property Name: secondaryMissionNeed
Property Type: text [Standard type: ANSI C++ string (long)]
Provide a short (5-20 words) description of any secondary missions supported by this system.
 System Purpose
Property Name: systemPurpose
Property Type: text [Standard type: ANSI C++ string (long)]
Provide a short (10-20 words) description of what the system is used for. (This is a lower level than the system's mission(s) above.)
 Life Cycle Phase
Property Name: lifeCyclePhase
Property Type: Life Cycle Phase []
Select the term that best describes the state of this system.
 Key Characteristics
Property Name: keyCharacteristics
Property Type: text [Standard type: ANSI C++ string (long)]
Describe key characteristics (components, size, system types, etc.). Identify key performance parameters.
 Major Modes of Operation
Property Name: modesOfOperation
Property Type: text [Standard type: ANSI C++ string (long)]
Describe the typical ways in which this system is operated. Identify the normal modes and any out-of-normal modes.
 Growth Plans
Property Name: growthPlans
Property Type: text [Standard type: ANSI C++ string (long)]
Describe the plans and desires for upgrade and/or expansion of the system.
 System Picture URL
Property Name: systemPicture
Property Type: url [Standard type: URL as xlink]
Attach a file containing a graphic or picture of the system. Check 'Relative' if the URL is relative to the model location.
 Block Diagram URL
Property Name: blockDiagram
Property Type: url [Standard type: URL as xlink]
Attach a file containing a block diagram of the system. Check 'Relative' if the URL is relative to the model location.
 Schedule URL
Property Name: schedule
Property Type: url [Standard type: URL as xlink]
Attach a file containing acquisition and/or operations schedules for this system. Check 'Relative' if the URL is relative to the model location.
 Webpage URL
Property Name: referenceUrl
Property Type: url [Standard type: URL as xlink]
If one exists, enter the URL for the systems web site. The entire URL needs to be specified, i.e. http://www.refdesk.com/.
 Key Performance Parameters
Property Name: keyPerformanceParameters
Property Type: text [Standard type: ANSI C++ string (long)]
List the most important system parameters directly related to the primary mission.
 System Type
Property Name: systemType
Property Type: System Type [Type of system]
Identify type of system.
 Primary Stakeholders
Property Name: primaryStakeholders
Property Type: string [Standard type: ANSI C++ string (short)]
List the mosts important groups or organizations impacted by this system. This value is transferred from the name property of the associated primary stakeholder Organizations.
 Secondary Stakeholders
Property Name: secondaryStakeholders
Property Type: string [Standard type: ANSI C++ string (short)]
List other groups or organizations that are impacted by this system. This value is transferred from the name property of the associated secondary stakeholder Organizations.
 Users of System Data
Property Name: users
Property Type: string [Standard type: ANSI C++ string (short)]
List groups or organizations that use the data directly from this system. This value is transferred from the name property of the associated user Organizations.
 Downstream Users
Property Name: downstreamUsers
Property Type: string [Standard type: ANSI C++ string (short)]
List the groups or organizations that make use of data products derived from the direct system output. This value is transferred from the name property of the associated downstream user Organizations.
 Observational Scope -> Local
Property Name: observationalScope.local
Property Type: Boolean [Standard type: Boolean enum type]
 Observational Scope -> National
Property Name: observationalScope.national
Property Type: Boolean [Standard type: Boolean enum type]
 Observational Scope -> Regional
Property Name: observationalScope.regional
Property Type: Boolean [Standard type: Boolean enum type]
 Observational Scope -> Global
Property Name: observationalScope.global
Property Type: Boolean [Standard type: Boolean enum type]
 Observational Scope -> Space
Property Name: observationalScope.space
Property Type: Boolean [Standard type: Boolean enum type]
 Decisionmaking -> Local
Property Name: decisionMaking.local
Property Type: Boolean [Standard type: Boolean enum type]
 Decisionmaking -> National
Property Name: decisionMaking.national
Property Type: Boolean [Standard type: Boolean enum type]
 Decisionmaking -> Regional
Property Name: decisionMaking.regional
Property Type: Boolean [Standard type: Boolean enum type]
 Decisionmaking -> Global
Property Name: decisionMaking.global
Property Type: Boolean [Standard type: Boolean enum type]
 Quantity Deployed (Current)
Property Name: qtyDeployed
Property Type: integer [Standard type: 32 bit signed integer]
How many Observing Systems are currently deployed?
 Quantity Deployed (Programmed)
Property Name: qtyPlannedDeployed
Property Type: integer [Standard type: 32 bit signed integer]
How many additional Observing Systems will be deployed to the 03/04 budget plan?
 Quantity Needed
Property Name: qtyNeeded
Property Type: integer [Standard type: 32 bit signed integer]
How many Observing Systems total are needed to meet the requirements of users?
 Funding - Organizations
Property Name: funding1
Property Type: string [Standard type: ANSI C++ string (short)]
List all organizations that contribute funds to this observing system. This value is transferred from the name property of the associated funding Organizations.
 Funding - Higher Level Systems
Property Name: funding2
Property Type: string [Standard type: ANSI C++ string (short)]
List any higher level systems that contribute to the funding of this observing system. This value is transferred from the name property of the associated funding Higher Systems.
 Acquiring Organization
Property Name: acquiringOrganization
Property Type: string [Standard type: ANSI C++ string (short)]
List the name of the organization responsible for acquisition of this observing syhstem. This value is transferred from the name property of the associated acquiring Organization(s).
 Acquisition Authority
Property Name: acquisitionAuthority
Property Type: text [Standard type: ANSI C++ string (long)]
Describe the authority under which this system is being acquired, for example, a congressional mandate, or support for a NOAA strategic goal.
 Initial Acquisition Cost
Property Name: initialAcquisitionCost
Property Type: integer [Standard type: 32 bit signed integer]
 Acquisition Cost Type
Property Name: costType
Property Type: Cost Type []
Specify if this cost is per unit, or total.
 Subsequent Upgrade Cost
Property Name: subsequentUpgradeCost
Property Type: integer [Standard type: 32 bit signed integer]
 OandM Costs -> Total
Property Name: omCosts.total
Property Type: integer [Standard type: 32 bit signed integer]
Enter the total cost, or the cost for each subelement.
 OandM Costs -> Equipment
Property Name: omCosts.equipment
Property Type: integer [Standard type: 32 bit signed integer]
 OandM Costs -> Personnel
Property Name: omCosts.personnel
Property Type: integer [Standard type: 32 bit signed integer]
 OandM Costs -> Facilities
Property Name: omCosts.facilities
Property Type: integer [Standard type: 32 bit signed integer]
 OandM Costs -> Data
Property Name: omCosts.data
Property Type: integer [Standard type: 32 bit signed integer]
 OandM Costs -> Services
Property Name: omCosts.services
Property Type: integer [Standard type: 32 bit signed integer]
 OandM Costs -> Other
Property Name: omCosts.other
Property Type: integer [Standard type: 32 bit signed integer]
Enter the sum total of O&M costs not covered by the previous properties. Describe the nature of these costs in the comment area for this property.
 Schedule -> IOC
Property Name: scheduleDate.ioc
Property Type: Date [Date represented as YYYYMMDD]
Enter the date that this system achieved IOC (Initial Operating Capability)
 Schedule -> FOC
Property Name: scheduleDate.foc
Property Type: Date [Date represented as YYYYMMDD]
Enter the date that this system achieved (or will achieve) FOC (Full Operating Capability)
 Schedule -> EOFC
Property Name: scheduleDate.eofc
Property Type: Date [Date represented as YYYYMMDD]
Enter the date (or projected date) at which this system no longer perform at full specified capabilty, known as the EOFC (End of Full Capability)
 Schedule -> EOL
Property Name: scheduleDate.eol
Property Type: Date [Date represented as YYYYMMDD]
Enter the projected date of End of Life (EOL) for this system
 Capital Asset Plan
Property Name: capitalAssetPlan
Property Type: url [Standard type: URL as xlink]
Attach a file containing the Capital Asset Plan for this system if one exists. Check 'Relative' if the URL is relative to the model location.
Inherited properties
 NOSA Abstract Basetype : DBIF Identifier
Property Name: id
Property Type: string [Standard type: ANSI C++ string (short)]
Unique identifier of this object. Used for the Database Interface import.
Methods
 getOrganizationAcquires
http://xml.noaa.gov/xml/object_types/observing_system.kmd#oid33
 getOrganizationDownstreamUser
http://xml.noaa.gov/xml/object_types/observing_system.kmd#oid31
 Open Reference URL
http://xml.noaa.gov/xml/object_types/observing_system.kmd#oid10
 Open System Picture
http://xml.noaa.gov/xml/object_types/observing_system.kmd#oid11
 Open Block Diagram
http://xml.noaa.gov/xml/object_types/observing_system.kmd#oid12
 Open Schedule
http://xml.noaa.gov/xml/object_types/observing_system.kmd#oid13
 getOrganizationFunds
http://xml.noaa.gov/xml/object_types/observing_system.kmd#oid23
 getHigherSystem
http://xml.noaa.gov/xml/object_types/observing_system.kmd#oid21
 getOrganizationPrimaryStakeholder
http://xml.noaa.gov/xml/object_types/observing_system.kmd#oid25
 getOrganizationSecondaryStakeholder
http://xml.noaa.gov/xml/object_types/observing_system.kmd#oid27
 getOrganizationUser
http://xml.noaa.gov/xml/object_types/observing_system.kmd#oid29
 Observation Control System
xe "Object Type : Observation Control System"http://xml.noaa.gov/xml/object_types/observation_control_system.kmd#oid1
	


	Default Symbol


Basetype
 NOSA Abstract Basetype
Connections with other Object Types
	Direction
	Relationship Type
	Object Type

	

	Use
	Business Process

	

	Is controlled by
	Observing System


Properties
 Name
Property Name: name
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
Note that this property is also the label property. The value for the label property can be displayed on a tooltip (when the preference is set in Metis) and is usually displayed on the symbol. The value of this property is also displayed for the object in the Object and View trees.
 Description
Property Name: description
Property Type: Description with Rich Text [Standard type: ANSI C++ string (long)]
Inherited properties
 NOSA Abstract Basetype : DBIF Identifier
Property Name: id
Property Type: string [Standard type: ANSI C++ string (short)]
Unique identifier of this object. Used for the Database Interface import.
 Mobile Location Data
xe "Object Type : Mobile Location Data"http://xml.noaa.gov/xml/object_types/location.kmd#oid1
	


	Default Symbol


Basetype
 Location Data
Connections with other Object Types
	Direction
	Relationship Type
	Object Type

	

	Located at
	Platform/Station


Properties
 Location Matrix data
Property Name: locations
Property Type: Mobile Locations []
Fixed location coordinates for each Station or Platform.
Inherited properties
 Location Data : DBIF Identifier
Property Name: id
Property Type: string [Standard type: ANSI C++ string (short)]
Unique identifier of this object. Used for the Database Interface import.
 Location Data : Location Matrix file reference
Property Name: locationMatrix
Property Type: url [Standard type: URL as xlink]
Enter the URL of a file that specifies the location data of each Station or Platform. Locations should be specified in terms of the appropriate location data.
 Location Data : Webpage URL
Property Name: webPage
Property Type: url [Standard type: URL as xlink]
If one exists, enter the URL for the locations web site. The entire URL needs to be specified, i.e. http://www.refdesk.com/. Check 'Relative' if the URL is relative to the model location.
 Location Data : Picture URL
Property Name: picture
Property Type: url [Standard type: URL as xlink]
If one exists, enter the URL for the locations picture. The entire URL needs to be specified, i.e. http://www.refdesk.com/pictures/image.jpg. Check 'Relative' if the URL is relative to the model location.
Inherited properties
 Location : Street
Property Name: street
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
Street address
 Location : Zip Code
Property Name: zipCode
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
Zip code
 Location : Post Box
Property Name: postBox
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
Postal Box address section
 Location : City
Property Name: city
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
City, Town, or equivalent
Inherited properties
 Location Type : Name
Property Name: name
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
Enter a short name for the object
Note that this property is also the label property. The value for the label property can be displayed on a tooltip (when the preference is set in Metis) and is usually displayed on the symbol. The value of this property is also displayed for the object in the Object and View trees.
 Location Type : Description
Property Name: description
Property Type: Description with Rich Text [Standard type: ANSI C++ string (long)]
Enter a description of the object
 Required Measurement
xe "Method : getGoal (Required Measurement)"

xe "Object Type : Required Measurement"http://xml.noaa.gov/xml/object_types/measurement_requirement.kmd#oid1
	


	Default Symbol


Basetype
 Requirement
Connections with other Object Types
	Direction
	Relationship Type
	Object Type

	

	Applies to
	Environmental Parameter

	

	Supports
	Goal

	

	Met by
	Actual Measurement


Properties
 Measurement -> Algorithm
Property Name: measurement.algorithm
Property Type: text [Standard type: ANSI C++ string (long)]
Describe at a high level how this environmental parameter is derived. (E.g., Apparent Temperature is calculated using Air Temperature, Humidity, and Wind Speed.)
 Measurement -> Measurement Unit
Property Name: measurement.unit
Property Type: Unit []
Specify the units this parameter is normally expressed in.
 Measurement -> Minimum Measurement Value
Property Name: measurement.min
Property Type: float [Standard type: 64 bit floating point]
Specify the lower measurement bound (minimum) for this parameter expressed in the units selected in the Measurement Unit property.
 Measurement -> Maximum Measurement Value
Property Name: measurement.max
Property Type: float [Standard type: 64 bit floating point]
Specify the upper measurement bound (maximum) for this parameter expressed in the units selected in the Measurement Unit property.
 Measurement -> Representative Measurement Accuracy
Property Name: measurement.accuracy
Property Type: float [Standard type: 64 bit floating point]
For the given sensing element specify representative measurement accuracy. Measurement Accuracy represents the systematic error as specified by the difference between a measured or derived parameter and its true value in the absence of random errors.
 Measurement -> Representative Measurement Precision
Property Name: measurement.precision
Property Type: float [Standard type: 64 bit floating point]
For the given sensing element specify representative measurement precision. Measurement Precision is the uncertainty in a measured or derived parameter due only to random errors, specified as the standard deviation of a parameter. 
 Measurement -> Representative Measurement Uncertainty
Property Name: measurement.uncertainty
Property Type: float [Standard type: 64 bit floating point]
For the given sensing element specify representative measurement uncertainty. Measurement Uncertainty is the root-mean-square of the measurement errors for an estimated parameter. 
 Environmental Parameter Timeline
Property Name: timeline
Property Type: text [Standard type: ANSI C++ string (long)]
Describe the measurement timeline for this Environmental Parameter including sampling, integrating, and reporting process. Address latency and persistence if known.
 Timeline Unit
Property Name: timelineUnit
Property Type: string [Standard type: ANSI C++ string (short)]
Enter the timeline unit (e.g. seconds, minutes)
 Reporting Frequency
Property Name: reportingFrequency
Property Type: float [Standard type: 64 bit floating point]
Provide the shortets Reporting Frequency (e.g. 10 minutes) for this Environmental Parameter.
 Sample Frequency
Property Name: sampleFrequency
Property Type: float [Standard type: 64 bit floating point]
If different from Reporting Frequency, provide the shortest Sample Frequency for this Environmental Parameter. 
 Sampling Duration
Property Name: samplingDuration
Property Type: float [Standard type: 64 bit floating point]
Provide the shortest Sample Duration for this Environmental Parameter.
 Measurement Stability
Property Name: measurementStability
Property Type: text [Standard type: ANSI C++ string (long)]
Describe the Environmental Parameter stability addressing both the time needed to average over to ensure the averaging out of noise, but short enough so that meaningful analysis/trends/results are derived.
 Measurement Extent
Property Name: measurementExtent
Property Type: text [Standard type: ANSI C++ string (long)]
Describe the measurement extent (e.g. temperature at a single point, fish in a given area, soil moisture for a given cylinder with depth, or aerosol extinction as a function of sensing depth).
 Mapping Uncertainty
Property Name: mappingUncertainty
Property Type: text [Standard type: ANSI C++ string (long)]
Specify necessary mapping (location and extent) accuracy for this envrionmental parameter.
 Other Key Parameters
Property Name: otherKeyParameters
Property Type: text [Standard type: ANSI C++ string (long)]
Please define other key parameter properties your program uses that were not requested above that describe the measurement fidelity. Please review the remote sensing section for coverage related properties.
 General Coverage Description
Property Name: coverage
Property Type: text [Standard type: ANSI C++ string (long)]
 GIS Coverage Data
Property Name: gisCoverageData
Property Type: text [Standard type: ANSI C++ string (long)]
 Driving Requirements
Property Name: drivingRequirements
Property Type: text [Standard type: ANSI C++ string (long)]
 Key Questions
Property Name: keyQuestions
Property Type: string [Standard type: ANSI C++ string (short)]
 Interested Community
Property Name: interestedCommunity
Property Type: string [Standard type: ANSI C++ string (short)]
 Strategic Goals
Property Name: strategicGoals
Property Type: string [Standard type: ANSI C++ string (short)]
 Other Needs
Property Name: otherNeeds
Property Type: text [Standard type: ANSI C++ string (long)]
Inherited properties
 General Requirement : Name
Property Name: name
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
Enter a short name for the object
Note that this property is also the label property. The value for the label property can be displayed on a tooltip (when the preference is set in Metis) and is usually displayed on the symbol. The value of this property is also displayed for the object in the Object and View trees.
 General Requirement : Description
Property Name: description
Property Type: Description with Rich Text [Standard type: ANSI C++ string (long)]
Enter a description of the object
 General Requirement : No Label
Property Name: priority
Property Type: Priority []
Priority of the requirement.
 General Requirement : No Label
Property Name: Color
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
Methods
 getGoal
http://xml.noaa.gov/xml/object_types/measurement_requirement.kmd#oid13
 Location
xe "Object Type : Location"http://xml.noaa.gov/xml/object_types/location.kmd#oid9
	


	Default Symbol


Basetype
 Location
Connections with other Object Types
	Direction
	Relationship Type
	Object Type

	

	Area of Operations
	Observing System


Properties
 Identifier
Property Name: id
Property Type: string [Standard type: ANSI C++ string (short)]
 Location Code
Property Name: locationCode
Property Type: string [Standard type: ANSI C++ string (short)]
 Address 1
Property Name: address1
Property Type: string [Standard type: ANSI C++ string (short)]
 Address 2
Property Name: address2
Property Type: string [Standard type: ANSI C++ string (short)]
 City
Property Name: city
Property Type: string [Standard type: ANSI C++ string (short)]
 State/Province
Property Name: stateProvince
Property Type: string [Standard type: ANSI C++ string (short)]
 Postal Code
Property Name: postalCode
Property Type: string [Standard type: ANSI C++ string (short)]
 Country
Property Name: country
Property Type: string [Standard type: ANSI C++ string (short)]
 Phone No.
Property Name: phoneNr
Property Type: string [Standard type: ANSI C++ string (short)]
Inherited properties
 Location : Street
Property Name: street
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
Street address
 Location : Zip Code
Property Name: zipCode
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
Zip code
 Location : Post Box
Property Name: postBox
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
Postal Box address section
 Location : City
Property Name: city
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
City, Town, or equivalent
Inherited properties
 Location Type : Name
Property Name: name
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
Enter a short name for the object
Note that this property is also the label property. The value for the label property can be displayed on a tooltip (when the preference is set in Metis) and is usually displayed on the symbol. The value of this property is also displayed for the object in the Object and View trees.
 Location Type : Description
Property Name: description
Property Type: Description with Rich Text [Standard type: ANSI C++ string (long)]
Enter a description of the object
 Group
xe "Object Type : Group"http://xml.noaa.gov/xml/object_types/group.kmd#oid1
	


	Default Symbol


Basetype
 NOSA Abstract Basetype
Connections with other Object Types
	Direction
	Relationship Type
	Object Type

	

	User
	Observing System

	

	Primary stakeholder
	Observing System

	

	Secondary stakeholder
	Observing System

	

	Downstream user
	Observing System


Properties
 Name
Property Name: name
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
Note that this property is also the label property. The value for the label property can be displayed on a tooltip (when the preference is set in Metis) and is usually displayed on the symbol. The value of this property is also displayed for the object in the Object and View trees.
 Description
Property Name: description
Property Type: Description with Rich Text [Standard type: ANSI C++ string (long)]
Inherited properties
 NOSA Abstract Basetype : DBIF Identifier
Property Name: id
Property Type: string [Standard type: ANSI C++ string (short)]
Unique identifier of this object. Used for the Database Interface import.
 Fixed Location Data
xe "Object Type : Fixed Location Data"http://xml.noaa.gov/xml/object_types/location.kmd#oid2
	


	Default Symbol


Basetype
 Location Data
Connections with other Object Types
	Direction
	Relationship Type
	Object Type

	

	Located at
	Platform/Station


Properties
 Location Matrix data
Property Name: locations
Property Type: Fixed Locations []
Fixed location coordinates for each Station or Platform.
Inherited properties
 Location Data : DBIF Identifier
Property Name: id
Property Type: string [Standard type: ANSI C++ string (short)]
Unique identifier of this object. Used for the Database Interface import.
 Location Data : Location Matrix file reference
Property Name: locationMatrix
Property Type: url [Standard type: URL as xlink]
Enter the URL of a file that specifies the location data of each Station or Platform. Locations should be specified in terms of the appropriate location data.
 Location Data : Webpage URL
Property Name: webPage
Property Type: url [Standard type: URL as xlink]
If one exists, enter the URL for the locations web site. The entire URL needs to be specified, i.e. http://www.refdesk.com/. Check 'Relative' if the URL is relative to the model location.
 Location Data : Picture URL
Property Name: picture
Property Type: url [Standard type: URL as xlink]
If one exists, enter the URL for the locations picture. The entire URL needs to be specified, i.e. http://www.refdesk.com/pictures/image.jpg. Check 'Relative' if the URL is relative to the model location.
Inherited properties
 Location : Street
Property Name: street
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
Street address
 Location : Zip Code
Property Name: zipCode
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
Zip code
 Location : Post Box
Property Name: postBox
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
Postal Box address section
 Location : City
Property Name: city
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
City, Town, or equivalent
Inherited properties
 Location Type : Name
Property Name: name
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
Enter a short name for the object
Note that this property is also the label property. The value for the label property can be displayed on a tooltip (when the preference is set in Metis) and is usually displayed on the symbol. The value of this property is also displayed for the object in the Object and View trees.
 Location Type : Description
Property Name: description
Property Type: Description with Rich Text [Standard type: ANSI C++ string (long)]
Enter a description of the object
 Environmental Product
xe "Object Type : Environmental Product"http://xml.noaa.gov/xml/object_types/environmental_product.kmd#oid1
	


	Default Symbol


Basetype
 Product Item
Connections with other Object Types
	Direction
	Relationship Type
	Object Type

	

	Reported to
	Environmental Phenomenon


Properties
 DBIF Identifier
Property Name: id
Property Type: string [Standard type: ANSI C++ string (short)]
Unique identifier of this object. Used for the Database Interface import.
Inherited properties
 General Product : Name
Property Name: name
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
Enter a short name for the object
Note that this property is also the label property. The value for the label property can be displayed on a tooltip (when the preference is set in Metis) and is usually displayed on the symbol. The value of this property is also displayed for the object in the Object and View trees.
 General Product : Description
Property Name: description
Property Type: Description with Rich Text [Standard type: ANSI C++ string (long)]
Enter a description of the object
 Environmental Phenomenon
xe "Method : getDrivingRequirements (Environmental Phenomenon)"

xe "Method : getEnvironmentalProducts (Environmental Phenomenon)"

xe "Object Type : Environmental Phenomenon"http://xml.noaa.gov/xml/object_types/environmental_phenomenon.kmd#oid1
	


	Default Symbol


Basetype
 NOSA Abstract Basetype
Connections with other Object Types
	Direction
	Relationship Type
	Object Type

	

	Characterizes
	Data Handling System

	

	Characterizes
	Actual Measurement

	

	Characterizes
	Environmental Parameter

	

	Drives
	Organization

	

	Drives
	Objective

	

	Drives
	Goal

	

	Reported to
	Environmental Product

	

	Leads to
	Characterization requirement


Properties
 Phenomenon Name
Property Name: name
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
Note that this property is also the label property. The value for the label property can be displayed on a tooltip (when the preference is set in Metis) and is usually displayed on the symbol. The value of this property is also displayed for the object in the Object and View trees.
 Acronym
Property Name: acronym
Property Type: string [Standard type: ANSI C++ string (short)]
 Identifier
Property Name: identifier
Property Type: string [Standard type: ANSI C++ string (short)]
 Description
Property Name: description
Property Type: Description with Rich Text [Standard type: ANSI C++ string (long)]
 Environmental Products
Property Name: environmentalProducts
Property Type: string [Standard type: ANSI C++ string (short)]
Identify the environmental products where this phenomenon is typically reported. This value is transferred from the name property of the associated Environmental Product(s)
 Driving Requirements
Property Name: drivingRequirements
Property Type: string [Standard type: ANSI C++ string (short)]
If known, the driving requirements measuring this phenomenon will contribute to addressing. Provide the source, source documentation, and general description of the requirement. This value is transferred from the name property of the associated Phenomenon Requirement(s).
 Key Questions
Property Name: keyQuestions
Property Type: text [Standard type: ANSI C++ string (long)]
If known, list key questions measuring this phenomenon will contribute to addressing.
Inherited properties
 NOSA Abstract Basetype : DBIF Identifier
Property Name: id
Property Type: string [Standard type: ANSI C++ string (short)]
Unique identifier of this object. Used for the Database Interface import.
Methods
 getDrivingRequirements
http://xml.noaa.gov/xml/object_types/environmental_phenomenon.kmd#oid23
 getEnvironmentalProducts
http://xml.noaa.gov/xml/object_types/environmental_phenomenon.kmd#oid21
 Environmental Parameter
xe "Criterium : Find Observing Systems (Environmental Parameter)"

xe "Method : getEnvironmentalPhenomenon (Environmental Parameter)"

xe "Object Type : Environmental Parameter"http://xml.noaa.gov/xml/object_types/environmental_parameter.kmd#oid1
	


	Default Symbol


Basetype
 NOSA Abstract Basetype
Connections with other Object Types
	Direction
	Relationship Type
	Object Type

	

	Applies to
	Required Measurement

	

	Measures
	Actual Measurement

	

	Characterizes
	Environmental Phenomenon

	

	Drives
	Organization

	

	Drives
	Objective

	

	Drives
	Goal


Properties
 Environmental Parameter Name
Property Name: name
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
Enter the name of this Environmental Parameter.
Note that this property is also the label property. The value for the label property can be displayed on a tooltip (when the preference is set in Metis) and is usually displayed on the symbol. The value of this property is also displayed for the object in the Object and View trees.
 Description
Property Name: description
Property Type: Description with Rich Text [Standard type: ANSI C++ string (long)]
Provide a short description of this parameter.
 Associated Environmental Phenomena
Property Name: environmentalPhenomena
Property Type: string [Standard type: ANSI C++ string (short)]
Identify all the Environmental Phenomena that this environmental parameter is used to characterize. This value is transferred from the name property of the associated Environmental Phenomena
Inherited properties
 NOSA Abstract Basetype : DBIF Identifier
Property Name: id
Property Type: string [Standard type: ANSI C++ string (short)]
Unique identifier of this object. Used for the Database Interface import.
Criteria
 Find Observing Systems
http://xml.noaa.gov/xml/criteria/criteria.kmd#oid3
Methods
 getEnvironmentalPhenomenon
http://xml.noaa.gov/xml/object_types/environmental_parameter.kmd#oid21
 Data Handling System
xe "Object Type : Data Handling System"http://xml.noaa.gov/xml/object_types/data_handling_system.kmd#oid1
	


	Default Symbol


Basetype
 NOSA Abstract Basetype
Connections with other Object Types
	Direction
	Relationship Type
	Object Type

	

	Use
	Business Process

	

	Provides info to
	Organization

	

	Provides data to
	Processing Element

	

	Characterizes
	Environmental Phenomenon

	

	Sent to
	Message


Properties
 System Name
Property Name: name
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
Enter the name of the Data Handling System.
Note that this property is also the label property. The value for the label property can be displayed on a tooltip (when the preference is set in Metis) and is usually displayed on the symbol. The value of this property is also displayed for the object in the Object and View trees.
 Acronym
Property Name: acronym
Property Type: string [Standard type: ANSI C++ string (short)]
Enter the acronym of the Data Handling System.
 Identifier
Property Name: identifier
Property Type: string [Standard type: ANSI C++ string (short)]
Enter the identifier of the Data Handling System.
 System Type
Property Name: systemType
Property Type: string [Standard type: ANSI C++ string (short)]
 Description
Property Name: description
Property Type: Description with Rich Text [Standard type: ANSI C++ string (long)]
Enter a description for the Data Handling System.
 Models
Property Name: models
Property Type: text [Standard type: ANSI C++ string (long)]
Are any of the collected observations used in operationsl models? If so, describe what is used, how it is used, and what models are used.
 Data Collection
Property Name: dataCollection
Property Type: text [Standard type: ANSI C++ string (long)]
How is data collected and/or ingested?
 Data Request
Property Name: dataRequest
Property Type: text [Standard type: ANSI C++ string (long)]
How is data requested by users?
 Product Generation
Property Name: productGeneration
Property Type: text [Standard type: ANSI C++ string (long)]
How and how often are products generated?
 Data Archival
Property Name: dataArchival
Property Type: text [Standard type: ANSI C++ string (long)]
How is data archived, and for how long is it archived?
 Data Dissemination
Property Name: dataDissemination
Property Type: text [Standard type: ANSI C++ string (long)]
How is data disseminated and made accessible to users?
 Metadata
Property Name: metadata
Property Type: text [Standard type: ANSI C++ string (long)]
What metadata is needed by models, report generators, archival systems, users, etc?
Inherited properties
 NOSA Abstract Basetype : DBIF Identifier
Property Name: id
Property Type: string [Standard type: ANSI C++ string (short)]
Unique identifier of this object. Used for the Database Interface import.
 Characterization requirement
xe "Object Type : Characterization requirement"http://xml.noaa.gov/xml/object_types/characterization_requirement.kmd#oid1
	


	Default Symbol


Basetype
 Requirement
Connections with other Object Types
	Direction
	Relationship Type
	Object Type

	

	Leads to
	Environmental Phenomenon


Properties
Inherited properties
 General Requirement : Name
Property Name: name
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
Enter a short name for the object
Note that this property is also the label property. The value for the label property can be displayed on a tooltip (when the preference is set in Metis) and is usually displayed on the symbol. The value of this property is also displayed for the object in the Object and View trees.
 General Requirement : Description
Property Name: description
Property Type: Description with Rich Text [Standard type: ANSI C++ string (long)]
Enter a description of the object
 General Requirement : No Label
Property Name: priority
Property Type: Priority []
Priority of the requirement.
 General Requirement : No Label
Property Name: Color
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
 Platform/Station Type
xe "Object Type : Platform/Station Type"http://xml.noaa.gov/xml/object_types/platform_station_type.kmd#oid1
	


	Default Symbol


Basetype
 NOSA Abstract Basetype
Connections with other Object Types
	Direction
	Relationship Type
	Object Type

	

	Is type of
	Platform/Station


Properties
 Platform/Station Type Name
Property Name: name
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
Enter the name for the Platform/Station Type.
Note that this property is also the label property. The value for the label property can be displayed on a tooltip (when the preference is set in Metis) and is usually displayed on the symbol. The value of this property is also displayed for the object in the Object and View trees.
 Description
Property Name: description
Property Type: Description with Rich Text [Standard type: ANSI C++ string (long)]
Enter a description for the Platform/Station Type.
Inherited properties
 NOSA Abstract Basetype : DBIF Identifier
Property Name: id
Property Type: string [Standard type: ANSI C++ string (short)]
Unique identifier of this object. Used for the Database Interface import.
 Message
xe "Object Type : Message"http://xml.noaa.gov/xml/object_types/message.kmd#oid1
	


	Default Symbol


Basetype
 Message
Connections with other Object Types
	Direction
	Relationship Type
	Object Type

	

	Transmits
	Processing Element

	

	Sent to
	Data Handling System


Properties
 DBIF Identifier
Property Name: id
Property Type: string [Standard type: ANSI C++ string (short)]
 Media Formats - Hardcopy -> Imagery/Photographs
Property Name: mediaFormatsHardcopy.imageryPhotographs
Property Type: Boolean [Standard type: Boolean enum type]
 Media Formats - Hardcopy -> Maps
Property Name: mediaFormatsHardcopy.maps
Property Type: Boolean [Standard type: Boolean enum type]
 Media Formats - Hardcopy -> Microfiche
Property Name: mediaFormatsHardcopy.microfiche
Property Type: Boolean [Standard type: Boolean enum type]
 Media Formats - Hardcopy -> Printer report
Property Name: mediaFormatsHardcopy.printerReport
Property Type: Boolean [Standard type: Boolean enum type]
 Media Formats - Hardcopy -> Reports
Property Name: mediaFormatsHardcopy.reports
Property Type: Boolean [Standard type: Boolean enum type]
 Media Formats - Digital -> Compact Discs
Property Name: mediaFormatsDigital.compactDiscs
Property Type: Boolean [Standard type: Boolean enum type]
 Media Formats - Digital -> Databases
Property Name: mediaFormatsDigital.databases
Property Type: Boolean [Standard type: Boolean enum type]
 Media Formats - Digital -> Files
Property Name: mediaFormatsDigital.files
Property Type: Boolean [Standard type: Boolean enum type]
 Media Formats - Digital -> Spreadsheets
Property Name: mediaFormatsDigital.spreadsheets
Property Type: Boolean [Standard type: Boolean enum type]
 Media Formats - Digital -> Voice
Property Name: mediaFormatsDigital.voice
Property Type: Boolean [Standard type: Boolean enum type]
 Data Format -> ASCII
Property Name: dataFormat.ascii
Property Type: Boolean [Standard type: Boolean enum type]
 Data Format -> CDF
Property Name: dataFormat.cdf
Property Type: Boolean [Standard type: Boolean enum type]
 Data Format -> HDF
Property Name: dataFormat.hdf
Property Type: Boolean [Standard type: Boolean enum type]
 Data Format -> HTML and FTP protocols
Property Name: dataFormat.htmlFtp
Property Type: Boolean [Standard type: Boolean enum type]
 Data Format -> Level-1B
Property Name: dataFormat.level1b
Property Type: Boolean [Standard type: Boolean enum type]
 Data Format -> NetCDF
Property Name: dataFormat.netCdf
Property Type: Boolean [Standard type: Boolean enum type]
 Data Format -> Voice
Property Name: dataFormat.voice
Property Type: Boolean [Standard type: Boolean enum type]
 Data Format -> XLS
Property Name: dataFormat.xls
Property Type: Boolean [Standard type: Boolean enum type]
 Metadata
Property Name: metadata
Property Type: text [Standard type: ANSI C++ string (long)]
 Data Processing -> Derived Products
Property Name: dataProcessing.derivedProducts
Property Type: Boolean [Standard type: Boolean enum type]
 Data Processing -> Raw Observations
Property Name: dataProcessing.rawObservations
Property Type: Boolean [Standard type: Boolean enum type]
 Data Processing -> Reviewed Observations
Property Name: dataProcessing.reviewedObservations
Property Type: Boolean [Standard type: Boolean enum type]
 Data Relay - Method
Property Name: dataRelayMethod
Property Type: text [Standard type: ANSI C++ string (long)]
 Data Relay - Timing
Property Name: dataRelayTiming
Property Type: string [Standard type: ANSI C++ string (short)]
 Data Access -> Customer Order via phone/fax
Property Name: dataAccess.customerOrder
Property Type: Boolean [Standard type: Boolean enum type]
 Data Access -> Dedicated Connections
Property Name: dataAccess.dedicatedConnection
Property Type: Boolean [Standard type: Boolean enum type]
 Data Access -> FTP Site
Property Name: dataAccess.ftpSite
Property Type: Boolean [Standard type: Boolean enum type]
 Data Access -> Web Pages
Property Name: dataAccess.webPages
Property Type: Boolean [Standard type: Boolean enum type]
 Data Retention - Local
Property Name: dataRetentionLocal
Property Type: string [Standard type: ANSI C++ string (short)]
 Data Retention - Period
Property Name: dataRetentionPeriod
Property Type: string [Standard type: ANSI C++ string (short)]
 Data Retention - Latency
Property Name: dataRetentionLatency
Property Type: string [Standard type: ANSI C++ string (short)]
Inherited properties
 Message : Name
Property Name: name
Property Type: Name with Rich Text [Standard type: ANSI C++ string (short)]
Enter a short name for the object
Note that this property is also the label property. The value for the label property can be displayed on a tooltip (when the preference is set in Metis) and is usually displayed on the symbol. The value of this property is also displayed for the object in the Object and View trees.
 Message : Description
Property Name: description
Property Type: Description with Rich Text [Standard type: ANSI C++ string (long)]
Enter a description of the object
 Applies to
xe "Relationship Type : Applies to"http://xml.noaa.gov/xml/relationship_types/applies_to.kmd#oid1
Basetype
 Relationship with shared from and to texts
Constraints
	From
	To

	Required Measurement
	Environmental Parameter


 Transmits
xe "Relationship Type : Transmits"http://xml.noaa.gov/xml/relationship_types/transmits.kmd#oid1
Basetype
 Relationship with shared from and to texts
Constraints
	From
	To

	Processing Element
	Message


 Supplied by
xe "Relationship Type : Supplied by"http://xml.noaa.gov/xml/relationship_types/supplied_by.kmd#oid1
Basetype
 Relationship with shared from and to texts
Constraints
	From
	To

	Sensing Element
	Organization


 Use
xe "Relationship Type : Use"http://xml.noaa.gov/xml/relationship_types/use.kmd#oid1
Basetype
 Relationship with shared from and to texts
Constraints
	From
	To

	Business Process
	Data Handling System

	Business Process
	Observation Control System


 Area of Operations
xe "Relationship Type : Area of Operations"http://xml.noaa.gov/xml/relationship_types/area_of_operations.kmd#oid1
Basetype
 Relationship with shared from and to texts
Constraints
	From
	To

	Observing System
	Location


 Has contact person
xe "Relationship Type : Has contact person"http://xml.noaa.gov/xml/relationship_types/has_contact_person.kmd#oid1
Basetype
 Relationship with shared from and to texts
Constraints
	From
	To

	Actual Measurement
	Person

	Organization
	Person


 Provides info to
xe "Relationship Type : Provides info to"http://xml.noaa.gov/xml/relationship_types/provides_info_to.kmd#oid1
Basetype
 Relationship with shared from and to texts
Constraints
	From
	To

	Data Handling System
	Organization


 Provides data to
xe "Relationship Type : Provides data to"http://xml.noaa.gov/xml/relationship_types/provides_data_to.kmd#oid1
Basetype
 Relationship with shared from and to texts
Constraints
	From
	To

	Processing Element
	Data Handling System


 Funds
xe "Relationship Type : Funds"http://xml.noaa.gov/xml/relationship_types/funds.kmd#oid1
Basetype
 Relationship with shared from and to texts
Constraints
	From
	To

	Organization
	Observing System

	Observing System
	Observing System


 User
xe "Relationship Type : User"http://xml.noaa.gov/xml/relationship_types/user.kmd#oid1
Basetype
 Relationship with shared from and to texts
Constraints
	From
	To

	Organization
	Observing System

	Group
	Observing System


 Primary stakeholder
xe "Relationship Type : Primary stakeholder"http://xml.noaa.gov/xml/relationship_types/primary_stakeholder.kmd#oid1
Basetype
 Relationship with shared from and to texts
Constraints
	From
	To

	Organization
	Observing System

	Group
	Observing System


 Owns
xe "Relationship Type : Owns"http://xml.noaa.gov/xml/relationship_types/owns_owned-by.kmd#oid1
Basetype
 Relationship with shared from and to texts
Constraints
	From
	To

	Organization
	Platform/Station

	Organization
	Observing System


 Situated on
xe "Relationship Type : Situated on"http://xml.noaa.gov/xml/relationship_types/situated-on.kmd#oid1
Basetype
 Relationship with shared from and to texts
Constraints
	From
	To

	Observing System
	Platform/Station


 Contains
xe "Relationship Type : Contains"http://xml.noaa.gov/xml/relationship_types/contains.kmd#oid1
Basetype
 Relationship with shared from and to texts
Constraints
	From
	To

	Observing System
	Sensing Element

	Observing System
	Processing Element


 Provides data for
xe "Relationship Type : Provides data for"http://xml.noaa.gov/xml/relationship_types/provides_data_for.kmd#oid1
Basetype
 Relationship with shared from and to texts
Constraints
	From
	To

	Sensing Element
	Processing Element


 Measures
xe "Relationship Type : Measures"http://xml.noaa.gov/xml/relationship_types/measures.kmd#oid1
Basetype
 Relationship with shared from and to texts
Constraints
	From
	To

	Actual Measurement
	Environmental Parameter


 Supports
xe "Relationship Type : Supports"http://xml.noaa.gov/xml/relationship_types/supports.kmd#oid1
Basetype
 Relationship with shared from and to texts
Constraints
	From
	To

	Observing System
	Goal

	Actual Measurement
	Goal

	Required Measurement
	Goal

	Organization
	Observing System


 Operates
xe "Relationship Type : Operates"http://xml.noaa.gov/xml/relationship_types/operates.kmd#oid1
Basetype
 Relationship with shared from and to texts
Constraints
	From
	To

	Organization
	Platform/Station

	Organization
	Observing System


 Characterizes
xe "Relationship Type : Characterizes"http://xml.noaa.gov/xml/relationship_types/characterizes.kmd#oid1
Basetype
 Relationship with shared from and to texts
Constraints
	From
	To

	Data Handling System
	Environmental Phenomenon

	Environmental Phenomenon
	Actual Measurement

	Environmental Phenomenon
	Environmental Parameter


 Drives
xe "Relationship Type : Drives"http://xml.noaa.gov/xml/relationship_types/drives.kmd#oid1
Basetype
 Relationship with shared from and to texts
Constraints
	From
	To

	Organization
	Environmental Phenomenon

	Objective
	Environmental Phenomenon

	Goal
	Environmental Phenomenon

	Organization
	Environmental Parameter

	Objective
	Environmental Parameter

	Goal
	Environmental Parameter


 Reported to
xe "Relationship Type : Reported to"http://xml.noaa.gov/xml/relationship_types/reported_to.kmd#oid1
Basetype
 Relationship with shared from and to texts
Constraints
	From
	To

	Environmental Phenomenon
	Environmental Product


 Located at
xe "Relationship Type : Located at"http://xml.noaa.gov/xml/relationship_types/located_at.kmd#oid1
Basetype
 Relationship with shared from and to texts
Constraints
	From
	To

	Platform/Station
	Mobile Location Data

	Platform/Station
	Fixed Location Data


 Secondary stakeholder
xe "Relationship Type : Secondary stakeholder"http://xml.noaa.gov/xml/relationship_types/secondary_stakeholder.kmd#oid1
Basetype
 Relationship with shared from and to texts
Constraints
	From
	To

	Organization
	Observing System

	Group
	Observing System


 Downstream user
xe "Relationship Type : Downstream user"http://xml.noaa.gov/xml/relationship_types/downstream_user.kmd#oid1
Basetype
 Relationship with shared from and to texts
Constraints
	From
	To

	Organization
	Observing System

	Group
	Observing System


 Acquires
xe "Relationship Type : Acquires"http://xml.noaa.gov/xml/relationship_types/acquires.kmd#oid1
Basetype
 Relationship with shared from and to texts
Constraints
	From
	To

	Organization
	Observing System


 Provides data directly to
xe "Relationship Type : Provides data directly to"http://xml.noaa.gov/xml/relationship_types/provides_data_directly_to.kmd#oid1
Basetype
 Relationship with shared from and to texts
Constraints
	From
	To

	Processing Element
	Organization


 Is controlled by
xe "Relationship Type : Is controlled by"http://xml.noaa.gov/xml/relationship_types/is_controlled_by.kmd#oid1
Basetype
 Relationship with shared from and to texts
Constraints
	From
	To

	Observing System
	Observation Control System


 Part of
xe "Relationship Type : Part of"http://xml.noaa.gov/xml/relationship_types/part_of.kmd#oid1
Basetype
 Relationship with shared from and to texts
Constraints
	From
	To

	Observing System
	Observing System


 Is type of
xe "Relationship Type : Is type of"http://xml.noaa.gov/xml/relationship_types/is_type_of.kmd#oid1
Basetype
 Relationship with shared from and to texts
Constraints
	From
	To

	Platform/Station
	Platform/Station Type

	Sensing Element
	Sensor Type


 Leads to
xe "Relationship Type : Leads to"http://xml.noaa.gov/xml/relationship_types/leads_to.kmd#oid1
Basetype
 Relationship with shared from and to texts
Constraints
	From
	To

	Characterization requirement
	Environmental Phenomenon


 Takes
xe "Relationship Type : Takes"http://xml.noaa.gov/xml/relationship_types/takes_measurement.kmd#oid1
Basetype
 Relationship with shared from and to texts
Constraints
	From
	To

	Sensing Element
	Actual Measurement


 Sent to
xe "Relationship Type : Sent to"http://xml.noaa.gov/xml/relationship_types/sent_to.kmd#oid1
Basetype
 Relationship with shared from and to texts
Constraints
	From
	To

	Message
	Data Handling System


 Met by
xe "Relationship Type : Met by"http://xml.noaa.gov/xml/relationship_types/met_by.kmd#oid1
Basetype
 Relationship with shared from and to texts
Constraints
	From
	To

	Required Measurement
	Actual Measurement


Not Found
The object type is not found in this reference guide.
Background
Relationship types may have constraints with references to object types that are part of the Common Modeling Library, but not available from any of the domains in this template. These object types are not documented in this reference guide.
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